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SMART Notebook Training (Intermediate) Learner Workbook
Best practices 
and tools
How can I  design ef fect ive and 
interact ive lesson act iv i t ies using 
SMART Notebook™ col laborat ive 
learning software?

Many tools are available for creating professional looking interactive lesson activities using 
SMART Notebook software. Here are some tips for designing lesson activities more effectively.
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Best practices and tools
1  Include teachers’ notes and lesson 
notes at the beginning of every 
lesson activity
Documenting learning objectives and 
key lesson details will help you focus 
your lesson activity during both design 
and delivery. It also provides a clear 
overview of the lesson to others who 
may use the file.

2  Use links to improve the flow of 
a lesson
You can significantly improve the flow 
and organization of your lesson by 
taking advantage of the linking 
capabilities in SMART Notebook 
software. You can link any object on a SMART Notebook page to a web page, an external 
file, an attached document or another page in the same file.

3  Attach supporting files to your SMART Notebook lesson before class
Browsing to find the files you want to show can be awkward and distracting. Your lesson can 
lose its momentum and students can lose their focus. To avoid this, attach files, shortcuts 
and Internet links to the Attachments tab of your SMART Notebook file. You can then open 
them with a single press. Everyone remains on track, and no time is wasted.

4  Use a consistent layout for lesson pages
Using a consistent layout for SMART Notebook pages helps your students know where to 
look for information and keeps them focused on important content. SMART Notebook 
software includes several themes that you can use as templates, or you can create your own 
incorporating school colors, logos and other objects.
2
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5  Create hands-on lessons
The SMART Board® interactive whiteboard 
is more than a teaching tool: it’s a learning 
tool. Students can use the interactive 
whiteboard to manipulate objects, complete 
activities, make notes during brainstorming 
sessions and deliver presentations.

6  Use the Internet and extra resources to 
encourage inquiry
Store links to relevant websites and 
additional resources as attachments in your 
SMART Notebook file. When students are 
particularly interested in a topic or have a question, these links can serve as a starting point 
for inquiry. Consider planning virtual field trips, or having the class compose an e-mail to an 
expert, an author, or another class with a question or idea about the interactive whiteboard.
 

7  Engage a variety of learning 
styles 
SMART Notebook software includes 
several tools that enable you to 
tailor lessons to a variety of learning 
preferences. Auditory learners will 
appreciate the sound capabilities. 
Kinesthetic learners will benefit from 
manipulating Adobe® Flash® 

activities. Visual learners will benefit 
from the rich Gallery collection 
included with SMART Notebook 
software, as well as from watching 
processes recorded using the Page Recorder or SMART Recorder.

8  Record processes, instructions or examples to provide further instruction 
when needed
SMART Notebook software includes a Page Recorder that enables you to record all actions 
on a SMART Notebook page. Consider recording a process or example to be played during 
class if students need additional clarification on a concept.
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Best practices and tools
9  Seek existing lesson activities 
on the Internet
Begin by searching the SMART Exchange™ 
website, which offers hundreds of ready-
made lesson activities and resources. 
Download and modify lesson activities to suit 
the needs of your students.
                                
10  Collaborate and share resources
Keep in regular contact with other educators 
who are using a SMART Board interactive 
whiteboard. Share experiences, ideas, 
challenges, lesson activities and solutions.
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Notes and ideas for designing effective lesson activities 
Use this page to write notes and ideas from the training session discussions.
 5





SMART Notebook Training (Intermediate) Learner Workbook
Review: Best practices and tools
  1  List three tips for designing effective lesson activities in SMART Notebook software.

  2  Which best practice will be most helpful to you when designing interactive lessons? Why?
 7



Best practices and tools
Review: Best practices and tools
  1  List three tips for designing effective lesson activities in SMART Notebook software.

•  Include teachers’ notes and lesson notes at the beginning of every lesson activity
•  Use links to improve the flow of a lesson
•  Attach supporting files to your SMART Notebook software file before class
•  Use a consistent layout for lesson pages
•  Create lessons that are hands-on for learners
•  Use the Internet and extra resources to encourage inquiry
•  Engage a variety of learning styles in each lesson activity
•  Record processes, instructions or examples to provide further instruction when needed
•  Seek lesson activities on the Internet
•  Collaborate and share resources with others

2  Which best practice will be most helpful to you when designing interactive lessons? Why?

 

8
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Structuring and 
organizing lessons
How can I  make my 
SMART Notebook f i les organized 
and easy to use?

The page grouping feature in SMART Notebook software enables you to organize pages. Links, 
buttons and attachments can help you improve the flow of a lesson activity. Additional features, 
such as the My Content folder, help you keep your learning objects and SMART Notebook files 
well organized.
 9



Structuring and organizing lessons
The Lesson Activity Toolkit
The Lesson Activity Toolkit is a Gallery collection full of ready-to-use content. It provides many tools 
and resources that can be helpful when preparing and delivering a lesson. 

You have the option of installing the Lesson Activity Toolkit when installing SMART Notebook 
software. However, if you did not install it at that time, you can download it by checking for updates.

To install or update the Lesson Activity Toolkit:

  1  Click the Show additional Gallery actions button in the Gallery tab
  2  Select Check for Updates > Lesson Activity Toolkit. The Lesson Activity Toolkit update 

wizard appears.
  3  Follow the prompts to install or update the Toolkit

Show additional Gallery actions button
10



SMART Notebook Training (Intermediate) Learner Workbook
Lesson Activity Toolkit contents
When installed, the Lesson Activity Toolkit will appear as a folder in the Gallery. It has the following 
six subfolders:

Activities – Activity templates are Flash-created objects that make it easy for you to create sorting, 
matching and other interactive lesson activities. 

Examples – The Examples folder includes filled-in content from the Activities, Pages, and Tools 
folders. These demonstrate the many dynamic and fun ways that SMART Notebook software can 
help you bring your lessons to life. Many examples include instructional videos that will tell you how 
to create them.

Games – The Games folder contains classic game objects like cards, game boards and 
playing pieces.

Graphics – The Graphics folder helps give your lessons a more professional look with its array of 
icons, borders, labels and pull tabs.

Pages – The Pages folder contains pre-made pages that save you time and effort when creating 
title pages, questions, and other lesson pages. Its contents are similar to those of the Activities 
folder, but consists entirely of SMART Notebook objects and are more customizable than activities.

Tools – Tools are Flash-created objects that perform a variety of actions from animated answer 
revealers, randomizers and timers.
 11



Structuring and organizing lessons
Adding title pages
Ready-made pages make it easier for you to add structure and style to your lessons. You can find 
templates for title pages and lesson pages – complete with title bars – in the Pages folder of the 
Lesson Activity Toolkit.

To add one of these templates to your lesson, drag it onto any page of the SMART Notebook file, 
then fill out the pages to suit your lesson activity. To change the text on the pages and title bars, 
highlight the existing text and start typing.

Title pages
Just as you would ask your students to include a title page on a book report, lab report or research 
project so that you know which student and class it’s for, it’s a good idea to include key details at 
the beginning of any activity you create or use. 

Documenting the subject, topic, grade level and learning outcomes at the beginning of your 
SMART Notebook file will help you to focus your efforts as you develop the lesson. You’ll easily find 
appropriate lesson activities when reusing your files in future years. Including key details will also 
make it easier for others to get an overview of the lesson if you share your resources. 

Lesson objectives
Insert the topic and learning 
objectives to provide an 
overview of the lesson 
activity.

These buttons provide easy 
links between the pages.
12
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Teachers’ notes
Use this page to detail 
information about the lesson 
such as topic or title. This 
action will be useful when 
you are sharing or revising 
the lesson activity. 

Lesson notes
Use this page to document 
comments and instructions 
for the lesson. You can also 
use this page during a 
lesson to keep track of 
student questions or 
improvements you would 
like to make to the lesson 
activity.
 13



Structuring and organizing lessons
Grouping pages
To keep your SMART Notebook files well organized, you can sort pages into groups. This is 
particularly useful when there are many pages in a file. Page grouping enables you to view your 
pages in an organized way. You can choose to show or hide specific groups, reducing the number 
of pages visible at a time. You can also rearrange the order of groups, quickly navigate to a 
particular group in the Page Sorter, and apply a theme to all the pages in a group. 

As a default, each SMART Notebook file has only one group. You can add and modify groups at 
any time. To view and edit groups:

  1  Open the Page Sorter tab
  2  Click the Groups button
  3  Select Edit Groups. If you have not yet edited the groups, all pages will be in the default 

group – Group 1. If you have already edited the groups for this file, the pages are displayed 
under the appropriate title bars.

Click to 
close the 
Groups 
view.

Click the 
Group 
drop-down 
menu to 
rename, 
move or 
delete a 
group.

Click to create a new group.

Each group
is identified

with a title
bar.

Click the
collapse
button to
hide the

pages in a
group.
14
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To create a new group:

  1  Click the Add New Group button. A new group title bar appears and a new blank page 
appears below it. Every group must include at least one page.

  2  Click the group drop-down arrow and select Rename Group
  3  Type a new name for the group

Pages and groups can easily be 
organized using the drag and drop 
method. To move a page to a 
different group or a different 
location in the same group, simply 
drag the thumbnail image for the 
SMART Notebook page to the 
desired location. To rearrange the 
order of groups, drag a group’s title 
bar to the new location. 
Alternatively, click the group 
drop-down menu and select Move 
Up or Move Down.

To delete a group, select Delete 
Group from the drop-down menu. 
When you delete a group, you also 
delete all pages in that group, so be 
sure to first move any pages you 
would like to keep into a different group. If you move all pages out of a group, the group disappears 
automatically.

To close the Groups view, click the Close button in the upper-right corner, or double-click any 
thumbnail image to navigate directly to that SMART Notebook page.

To move a page to a different location, within the same group or in a different 
group, drag it to the desired location. You can also change the order of 
groups using this method.
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Structuring and organizing lessons
When using the Page Sorter tab, you can 
navigate between groups easily without 
opening the Groups view. Click the Groups 
button at the top of the Page Sorter, and 
select the group from the drop-down list that 
appears. Select the

group you
would like to
see from the

drop-down list.

The selected
group will

appear in the
Page Sorter.
16
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Linking pages
You can significantly improve the flow and organization of your lesson by taking advantage of the 
linking capabilities in SMART Notebook software. You can link any object on a SMART Notebook 
page to a web page, an external file, an attached item or another page in the same 
SMART Notebook file. 

Linking enables you to move between pages quickly, without using the Page Sorter. Since any 
object can be linked, you can create objects that serve as navigation buttons or as messages 
for students. 

Many teachers like to write congratulatory messages or hints on specific pages, providing students 
with immediate feedback when they touch an object linked to that page. Linked navigation buttons 
on the message page enable students to return to the activity easily.

To respond to the question, 
the student presses the 
object that he believes 
causes acid rain. All three 
objects are linked to answer 
pages. After pressing an 
object, the student will be 
presented with one of the two 
pages shown here.
 17



Structuring and organizing lessons
Tips for keeping your linked file organized
To keep your SMART Notebook file well organized, add all your SMART Notebook pages before 
adding links. Place all answer pages at the back of the SMART Notebook file, and separate them 
from the lesson activity with a title page. The title page will prevent you from inadvertently displaying 
the answer pages to your students. 

Name each page with a unique, short and descriptive 
name to make the pages easy to identify when you’re 
creating the links.

To rename a page, select Rename Page from the page 
drop-down menu in the Page Sorter. Type the page 
name in the text box that appears.
18
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Creating links
To link an object to another page 
in the same SMART Notebook 
file, select Link from the object’s 
drop-down menu, and select 
Page in this File from the Insert 
Link dialog box. 

A list of the pages in the current 
SMART Notebook file will 
appear. Select the page you 
would like to link to. 
The Page Preview pane enables 
you to confirm your selection 
before creating the link.

Choose how you would like to 
launch the link by selecting Corner icon or Object. 
 19



Structuring and organizing lessons
Click OK to create the link. If you’re using a Mac® computer, click Insert Link to create the link. 

In this example, pressing anywhere on the object will link to a page titled Answer Yes, indicating 
that the object does contribute to acid rain. Brief but descriptive page names make it easy to select 
the correct SMART Notebook page for the link, and the Page Preview area confirms the selection.
20
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Adding attachments
Browsing to find the files you want to show can be awkward and distracting. Your lesson can lose 
its momentum and students can lose their focus. To avoid this, attach files, shortcuts to files, and 
Internet links to the Attachments tab of your SMART Notebook file. You can then open them with a 
single press. 

Attaching a copy of a file
You can add a copy of a file to the Attachments tab. This 
step enables you to keep all resources for a lesson in one 
place. But remember, when you attach a file, the size of 
your SMART Notebook file increases. A file that is too 
large could cause your computer to display pages slowly.

To add a copy of a file to the Attachments tab:

  1  Click the Insert button on the Attachments tab
  2  Select Insert Copy of File
  3  Browse to and select the file you would like to add 

and click the Open button

NOTE: When you open the file from the Attachments tab, 
it will be in read-only format. If you would like to save 
changes to a file stored in the Attachments tab, use 
Save As.

Attach supporting lesson files to a 
SMART Notebook file to save time 
 21
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Attaching a hyperlink
To save time and reduce distractions during your lesson, you can add hyperlinks to the Attachments 
tab, similar to saving bookmarks or favorites in your web browser. 

To add a hyperlink to the Attachments tab:

  1  Click the Insert button on the Attachments tab
  2  Select Insert Hyperlink
  3  Type the hyperlink address in the Hyperlink field
  4  Type the text you would like to see in the Attachments list – for example, the website name – 

in the Display name field
  5  Click OK

The hyperlink appears in the Attachments tab. To open the web page in your default browser, 
double-click the link.

Attaching a shortcut or alias
A shortcut is a link to a file located outside SMART Notebook software. To add a shortcut to the 
Attachments tab:

  1  Click the Insert button on the Attachments tab
  2  Select Insert Shortcut To File (or Alias on a Mac computer)
  3  Find and select the file you would like to add, and then click the Open button
22
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Organizing the My Content folder
You can add your own images, objects and entire SMART Notebook pages to the Gallery, or save 
your favorite items to an accessible location using the My Content folder. My Content is a Gallery 
collection reserved specifically for objects you have imported, captured or created. Save time and 
reduce extra work by adding templates or tools that you use on a regular basis, such as your school 
logo or a lesson template, to your My Content folder.

Adding items to the My Content folder
Drag the item from the work area, the Page Sorter or the 
Gallery to the My Content folder in the Gallery. 

To import additional files from your computer, including 
pictures you have taken with a digital camera or 
downloaded from the Internet:

  1  Select the Gallery Actions icon to the right of the 
Search button

  2  Select Add Other Files to My Content to launch 
the Add to My Content... dialog box

  3  Browse to and select the file you would like to add
  4  Click the Open button. Your file will appear as a 

thumbnail in the My Content area of the Gallery.

Organizing your content
Within the My Content folder, you can create your own 
folders and subfolders. Organize your Gallery content 
any way you like. 

To add a subfolder to My Content:

  1  Select the My Content menu arrow or a subfolder 
menu arrow

  2  Select New Folder. A new folder will appear. 
  3  Type a name for this folder

Create subfolders within My Content to organize 
learning objects according to grade or class.
 23



Structuring and organizing lessons
Adding keywords to objects in the My Content category
The search function in the Gallery works by scanning keywords associated with each Gallery item. 
When you add an item to the My Content category, you can associate keywords with the item so it 
appears in future search results.

To add keywords to a My Content item:

  1  Click the item’s thumbnail 
  2  Click the drop-down menu arrow
  3  Select Properties to launch the Gallery Item Properties dialog box
  4  Type the keywords you would like associated with the item. For example, you could type 

editing and symbol if the Gallery item is an editing symbol you frequently use.
  5  Click OK

Exporting a Gallery Collection
Importing and exporting collection files enables you to share custom folders. When you export a 
collection file, SMART Notebook saves the contents of the selected folder to a single file with a 
.gallery extension. After you create a collection file, you can move it to another computer or send it 
to other SMART Notebook users.

To export a Gallery collection:

  1  Select the folder that contains the items you want to save in a collection

NOTE: SMART Notebook exports the selected folder but doesn't export any of its subfolders.

  2  Click the folder's menu arrow, and then select Export as Collection File.
The Save As dialog box appears.

  3  Browse to the folder where you want to save the collection file
  4  Type a name for the file in the File name box
  5  Click Save
24
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Review: Structuring and organizing lessons
  1  List two ways to use links to improve the structure and organization of a lesson activity.

  2  How do you move a page from one group to another?

  3  Name three ways you can attach items to a SMART Notebook file.

  4  Why would you add a keyword to an item in the My Content folder?
 25
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Review: Structuring and organizing lessons
  1  List two ways to use links to improve the structure and organization of a lesson activity.

•  Link an object to another SMART Notebook page, eliminating the need to use the 
Page Sorter

•  Link an object to an attached file to eliminate the need to open the Attachments tab

  2  How do you move a page from one group to another?

Open the Page Sorter, click the Groups button and select Edit groups. To move a page 
to a different group, simply drag the thumbnail image for the SMART Notebook page to 
the desired location.

  3  Name three ways you can attach items to a SMART Notebook file.

You can add attachments as files, shortcuts to files or file aliases, and Internet links. 

  4  Why would you add a keyword to an item in the My Content folder?

You can add keywords to items in the My Content folder so that they can be located using 
the Search function in the Gallery.
26
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Adding style to 
lesson activities
How can I  create 
professional- looking lesson 
act iv i t ies?

SMART Notebook software includes many features that enable you to create lesson activities with 
a professional look. Themes, alignment tools and tables will enable you to create visually appealing 
SMART Notebook files. 
 27



Adding style to lesson activities
Inserting a theme
You can use themes to apply a consistent style to pages or groups of pages in a SMART Notebook 
file. The Gallery includes predefined themes, and you can also create your own. To apply an 
existing theme to a SMART Notebook page or a group of pages:

1  Open the Gallery tab
2  Select Backgrounds and Themes. The Gallery displays 

thumbnails of the available themes.
3  Select the thumbnail of the theme you want to apply
4  Click the thumbnail’s menu arrow and select Insert in 

Notebook. The Insert Theme dialog box appears.
5  Select which pages you would like to apply the theme to
6  Click OK

NOTE: The main difference between a theme and a background 
is that themes control the formatting of any typed text you add to 
the page. Another difference is that backgrounds can only be 
applied to single pages, whereas themes can be applied to 
multiple pages. You can identify a background by the folded 
bottom corner of the page thumbnail.

Theme

Background
28
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Creating and editing a theme
You can create a theme to meet your unique needs.

To create a new theme:

1  Select Format > Themes > Create Theme
2  Type a name for the theme in the Theme name box
3  Select the text object that appears in the work area, and modify the text to your desired 

default text style for the theme. This text object will not appear in the completed theme.
4  Modify the work area to reflect your new theme. You may need to scroll down to set up the 

entire SMART Notebook page. 
5  Click Save

NOTE: If you don’t want your custom theme to include a particular text style (font style and size), 
delete the text object that appears in the work area.

Deleting a theme
To delete a theme, right-click (Control-click) the work area and select Delete Theme. The theme 
will be deleted from every page it was applied to. To remove a theme from a single page only, apply 
a blank theme to that page.

Add objects to the work area as if it were a SMART Notebook page. You can set a default font by modifying 
the text object that appears in the work area. When finished, click the Save button.
 29



Adding style to lesson activities
Creating custom pen styles
By creating your own custom pen styles, you can highlight lesson material and draw students’ 
attention. It’s another way to add style to your lesson activities.

SMART Notebook software includes eight Creative pen styles. In addition to these styles, you can 
create your own using pictures or objects on the currently selected page. 

To create a custom Creative pen using a picture:

1  Click Pens. The Pens tool Contextual panel appears.
2  Click Pen Types, and then select the Creative Pen
3  Select a line type
4  If the Properties tab isn’t visible, click Properties
5  Click Line Style
6  Select Use a custom stamp image
7  Click Browse. The Insert Image File dialog box appears.
8  Browse to and select the picture you want to use for the Creative pen style
9  Click Open

10  Write or draw on the work area
30
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To create a custom Creative pen using an object:

1  Click Pens. The Pens tool Contextual panel appears.
2  Click Pen Types, and then select the Creative Pen
3  If the Properties tab isn’t visible, click Properties
4  Click Line Style
5  Select Use a custom stamp image
6  Click Select object, and then select an object on the page
7  Write or draw in digital ink on the work area

TIP: To resume using the default line type, select Use the default pattern. If you want to save 
your custom Creative pen style for future use, click Save Tool Properties. 
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To enable fading ink:

1  Click Pens. The Pens tool contextual panel appears.
2  Click Pen Types, and then select Pen
3  Select a line type
4  If the Properties tab isn’t visible, click Properties
5  Click Fill Effects
6  Select the Enable ink to fade after you write it check box, and then select the number of 

seconds between the time you write or draw the digital ink and the time it fades in the Fade 
time drop-down list

7  Write or draw in digital ink on the work area
32
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Creating and using tables 
To insert a table:

  1  Click the Table button or select Insert > Table. An eight-by-eight grid appears.

  2  Select the number of columns and rows that you would like to include in the table by dragging 
over the cells in the grid

  3  The table appears on the SMART Notebook page

Moving and resizing tables
To move a table on the SMART Notebook 
page or onto another page, select it. A 
square handle appears in the table’s 
upper-left corner. Use this handle to drag 
the table to the desired location, or click 
anywhere on the table’s selection 
rectangle.

To resize a table, select the table and click 
the resize handle in the lower-right corner 
of the table. Drag the handle to increase 
or reduce the size of the table.

Click and drag
this handle to

move the table.

Click and drag 
this handle to 
resize the 
table.
 33
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Resizing columns and rows 
You can resize rows and columns by clicking 
the table lines and dragging to adjust them to 
the preferred size.

For example, to expand the width of the first 
column, click the vertical line to the right of the 
column. A double-headed arrow appears. 
Drag the vertical line to the right to create a 
wider column. 

You can use this method to alter the size of 
any row or column, but you are limited by the 
height and width of the table. If you would like 
to increase the height or width of the table, drag its outer edge to the desired height or width.

Inserting or removing columns, rows or cells
After creating your table, you can customize it by inserting or removing columns, rows or cells. To 
add a new column or row, select a column or row, right-click (Control-click), or open the drop-down 
menu, and select Insert Column or Insert Row. New columns will appear to the right of the 
selected column. New rows will appear below the selected row. 

To remove a column or row, select it, right-click (Control-click), or open the drop-down menu, and 
select Delete Column or Delete Row. The currently selected row(s) or column(s) will be deleted.

You can also delete an individual cell or group of cells from a table. This can be useful when creating 
a crossword puzzle. To delete unnecessary cells, select the cell(s) you would like to delete, right-
click (Control-click) or open the drop-down menu and select Remove Cells.

Adding text and objects to tables
Once you’ve created your table, you can add text and objects, including freehand objects, 
geometric shapes, straight lines and graphic files to the table cells simply by dragging and dropping. 
To add text to a table cell, double-click it. A text box appears. To add an object to a table, select the 
object and drag it to the destination cell. To remove an object from a table, select it and drag it out 
of the table. 

TIP: Each cell can contain only one object. If you would like to add multiple objects to a cell, for 
example, an image and a text descriptor of the image, group the objects before adding them to 
the table.

To adjust column width, click on the line and drag it.
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Changing the properties of tables or cells
You can select a table, a column, a row, an individual cell or a selection of cells. After you’ve 
selected a table or a part of a table, you can modify the properties of the selected area. 

Selecting a table is easy using the marquee select method. Use the select tool, and drag a rectangle 
that encompasses the entire table.

To select cells, rows or columns, click inside the table area and drag over the cells you want 
to select.

More table tips and tricks
To expand your skills, experiment with these table features.

Splitting or merging table cells on a SMART Notebook page
To further customize the appearance of your table, you can split and merge cells. To split a cell 
means to turn one cell into two or more cells within the same area. SMART Notebook software 
provides several options for splitting cells, including Split into 2x2, Split into 3 rows and others.

To merge a cell means to turn two or more cells into one cell that then occupies the same area as 
the individual cells occupied. To merge cells, select the cells, right-click (Control-click), or open the 
drop-down menu, and select Merge.
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Adding cell shades
Cell shades are similar to a Screen Shade, but they cover and 
reveal the contents of individual cells within a table. Cell shades 
enable you to reveal the table content at a pace appropriate to the 
lesson. You can add a cell shade to an individual cell, a group of 
cells such as a row or column, or an entire table.

To add a shade to a cell, multiple cells or an entire table, select the 
cell(s). Right-click (Control-click), or open the drop-down menu, and 
select Add cell shade.

To remove a shade from a cell, multiple cells or an entire table, 
select the cell(s), right-click (Control-click), or open the drop-down 
menu, and select Remove cell shade.

To reveal the contents of a cell, click once on the cell shade. To replace the cell shade, click the cell 
shade triangle in the cell’s top-left corner.

The answers are hidden using 
cell shades. To reveal the 
contents, click once on the 
cell shade.
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Review: Adding style to lesson activities
  1  What are two options you can use to create custom Creative pens?

  2  How do you move a table?

  3  What’s the difference between a theme and a background?
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Review: Adding style to lesson activities
1  What are two options you can use to create custom Creative pens?

•  Object
•  Image

2  How do you move a table?

To move a table on the SMART Notebook page or onto another page, select it. A square 
handle appears in the table’s upper-left corner. Use this handle to drag the table to the 
desired location.

  3  What’s the difference between a theme and a background?

A theme controls the formatting of typed text on the page. A background does not. 
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Building interactive 
lesson activities
How can I  take advantage of  the 
interact ive features in 
SMART Notebook software in my 
lesson act iv i t ies?

SMART Notebook software includes many tools and features that enable you to make engaging 
and interactive lesson activities. Bringing students up to the interactive whiteboard provides them 
with a memorable hands-on experience. 
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Adding interactivity to lessons
Using an interactive whiteboard for a lesson adds a new level of interactivity, creating a stimulating 
and engaging learning environment. Design lessons that will bring students up to the interactive 
whiteboard to engage with lesson content directly. 

We’ll look at a few features of SMART Notebook software that will enable you to easily create more 
complex activities that appeal to a variety of learning preferences.

What lesson activities have you designed that bring students up to the interactive whiteboard? What 
have your peers created? use the table below to record your ideas.

Interactive whiteboard lesson activities
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Using the Lesson Activity Toolkit
The Lesson Activity Toolkit contains several interactive resources that will keep your students 
engaged and make learning fun.

Games and activities
The table below lists only some of the resources available in the Lesson Activity Toolkit, so be sure 
to browse through the folders to find additional activities and games that work for you. The 
Examples folders can help you think of some creative ways to use these resources.

To add an item from the Lesson Activity Toolkit to your lesson, select a thumbnail image and drag 
it onto the work area. 

Activities Games

Category sort Board games

Keyword or image match Crossword

Multiple choice Deck of cards

Sentence arrange Dice

Tiles Dominos

Timeline reveal Sudoku
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Editing an activity or game
Most interactive activity and game templates have an Edit button that enables you to customize the 
activity or game, and a Help button that displays detailed instructions for building and using it. Click 
Edit to get started. Fill in the blanks and make any selections required to set up the activity or game. 

When editing the activities, games and tools, you can add text by typing in the text fields, or by 
dragging text from the SMART Notebook page, word processing software, a web page or other 
software program, into the text fields. For example, when creating a multiple choice activity, you can 
drag both the questions and answers from an existing quiz in a word processing document.

To ensure that others cannot edit your activity or game, check the Password box and set a 
password. This prevents participants from accidentally accessing the edit area of the activity during 
class.

Click OK to save your edits.

Check this box and type in a 
password to protect the activity 
or game from being edited.

You can 
customize the 
parameters of 
many 
activities.

Check this box to show a Solve
button during the activity.
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Editing lesson pages
The Lesson Pages collection in the Pages folder of the Lesson Activity Toolkit is another great 
starting place for interactive lesson activities.

Many of these pages function similarly to those in the Activities folder. However, because they are 
constructed from SMART Notebook objects, you have more control over their appearance and 
functionality.

To add a lesson page template to your lesson, drag it onto any page in the SMART Notebook file, 
then fill out the page to suit your lesson activity. Double-click the default text to edit it.

Venn diagram example of a 
SMART Notebook lesson 
page template
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Using interactive tools
The Tools folder contains several 
useful tools, including random number, 
letter, card and domino generators, 
image and keyword dice, a voting tool, 
information buttons and word 
generators, scrolling text bars and 
many others, that you can use to add 
interactivity to your lesson activities. The tools in the Examples folder can help you generate ideas. 

When editing the tools, you can add text by typing in a text field, or by dragging text from the 
SMART Notebook page into a text field.
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Using the Activity Builder
The Activity Builder is located in the Add-ons tab. It enables you to create matching, sorting, and 
labeling activities using your own content.

Using the Activity Builder, you define one object on the page as the activity object. You then define 
which objects on the page will be accepted and which will be rejected when you drag them over the 
activity object. 

To create a matching lesson activity:

1  Create the object you want to use as the activity object and the objects you want to accept 
or reject

2  Open the Add-ons tab, and then click Activity Builder
3  Select the object you want to use as the activity object, and then click Edit

4  Drag the objects you want to accept to the Accept these objects list. A green check mark 
appears beside the objects you select to accept.

5  Drag the objects you want to reject to the Reject these objects list. A red X appears beside 
objects you select to reject.

6  Click Done

TIP: To remove an object from a list, drag it to the trash can icon.

Activity object

Rejected object

Accepted object
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To change a matching lesson activity’s settings:

1  Open the Add-ons tab
2  Select the activity object, and then press Edit
3  Press Settings 
4  Select the desired animation for accepted objects in the first Animation drop-down menu
5  Optionally, select the Also play the object’s sound check box to play sounds attached to 

accepted objects when they’re dragged over the activity object
6  Select the desired animation for rejected objects in the first Animation drop-down menu
7  Optionally, select the Also play the object’s sound check box to play sounds attached to 

rejected objects when they’re dragged over the activity object
8  Click Done

To remove a matching lesson activity:

1  Open the Add-ons tab and click Activity Builder
2  Select the activity object, and then click Clear Properties

TIP: If you don’t know which object on the page is the activity object, click Identify. Blue diagonal 
lines appear for three seconds over any activity objects on the page.

You can use the 
settings area to 
customize the 
way accepted 
and rejected 
objects behave.
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Dual Page Display and Pin Page
In some lesson activities, you may want to display two pages side by side. For example, you may 
want to display new vocabulary words on one page and an activity on another page, or steps to 
solving a math problem on one page and a math question for students to complete on another. 
You can display both these pages at once using Dual Page Display. You can draw, make notes, 
import files and add links on either page just as you would on a single page, and even move objects 
between the two pages.

Dual Page Display
To use Dual Page Display, click the View Screens button on the SMART Notebook toolbar, and 
then select Dual Page Display, or select View > Zoom > Dual Page Display. The work area will 
be split into two panes showing two consecutive SMART Notebook pages.

To close Dual Page Display, press View Screens on the SMART Notebook toolbar, and then select 
Single Page Display, or select View > Zoom > Single Page Display.

Dual Page Display enables two SMART Notebook pages to be displayed at the same time.
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Pin Page
When working in Dual Page Display, the Pin Page feature enables you to lock a page in place on 
one pane while still using the other pane to navigate through your SMART Notebook pages. For 
example, when introducing new vocabulary, you may want to keep a vocabulary list displayed on 
one pane, and display various activities in the other pane. This approach enables students to refer 
to the new terminology or drag the vocabulary words onto the activity pages as needed. 

To pin a page, navigate to the page you want to pin – in this scenario, the vocabulary list – and 
select View > Zoom > Pin Page. Thumbtack icons appear in the top corners of the pinned page. 
When you click the Next Page button, only one of the two displayed pages – the one without the 
thumbtack icons – will change. You can unpin the page by following the same steps.

The pin icons
indicate that

this page will
remain

stationary
when you

advance to
the next page.
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Strategic activity building
SMART Notebook software enables teachers to use a variety of techniques to build interactive 
lesson activities for their students. 

When building interactive activities, it’s important to engage your students’ higher levels of thinking. 
Plan to integrate interactive activities contextually into your lesson. Strategically build the activities 
to function as assessments, or to work as tasks that meet lesson outcomes.

For example, using linking, you could create a choose-your-own-adventure style lesson activity for 
students, which would encompass the knowledge, comprehension, application and analysis levels 
of Bloom’s taxonomy. 

However, you could engage students’ higher level thinking, moving into the synthesis and 
evaluation levels of Bloom’s taxonomy, by having them create their own activities based on a series 
of curricular objectives.
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Review: Building interactive lesson activities
  1  How do you enable Dual Page Display?

  2  Where is the Activity Builder located?

  3  Explain two ways to add text to an interactive activity, game or tool from the 
Lesson Activity Toolkit.
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Review: Building interactive lesson activities
1  How do you enable Dual Page Display?

Click the Dual Page Display button on the toolbar or select View > Zoom > 
Dual Page Display.

2  Where is the Activity Builder located?

The Activity Builder is located in the Add-ons tab.

3  Explain two ways to add text to an interactive activity, game or tool from the 
Lesson Activity Toolkit.

You can add text by typing into the text fields, or by dragging and dropping text from the 
SMART Notebook page, word processing software, a web page or other 
software program. 
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Integrating rich 
media into lesson 
activities
How can r ich media add value to 
my lesson act iv i t ies?

Rich media files and tools appeal to a variety of learning styles, can add interactivity to a lesson and 
can save you time.
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Integrating rich media into lesson activities
There are many ways that you can take advantage of various types of rich media when creating 
lesson activities with SMART Notebook software and a SMART Board interactive whiteboard. 

Attaching sound to objects
The sound capabilities of SMART Notebook software are an ideal tool for teaching language skills 
and will also appeal to auditory learners. Attaching an audio clip to an image enables students to 
see a word and hear it pronounced at the same time. You can also attach longer sound files, 
including sound effects, songs and conversations that students can listen to, repeat and discuss.

To attach a sound file to an object: 

  1  Select the object you would like to attach a sound file to
  2  Select Sound from the object’s drop-down menu. The Insert Sound dialog box appears.
  3  Type the name of the sound file to attach to the object, or click Browse to locate and select 

the sound file
  4  Click the Play button if you would like to preview the sound to ensure it is the right file
  5  Select whether you’d like to launch the sound by clicking a corner icon or the object itself
  6  Click OK. The sound file is now associated with the object and saved as a part of the 

SMART Notebook file.

Select whether you would like the sound file to launch when you click the 
object (in this case the image of the bear) or the corner icon.

Click the sound icon to 
hear the word “bear.”
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Recording sound
If you can’t find the sound you need, it’s easy to record one.

To record and attach a sound to an object:

1  Connect a microphone to your computer and turn it on
2  Select the object
3  Click the object’s menu arrow, and then select Sound. The Insert Sound dialog box 

appears.
4  Click Start Recording
5  Record the sound using the microphone
6  Click Stop Recording
7  Type a name for the sound in the Recording name box
8  Optionally, click Preview Recording to hear the sound before adding it to the object
9  Select Corner Icon if you want to play the sound file when you click the icon in the object’s 

lower-left corner.

OR

        Select Object if you want to play the sound file when you click anywhere on the object.

10  Click Attach Recording. Your recording is attached.
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Animating objects
You can help your students retain information and ensure that they receive immediate feedback 
from lesson activities by using object animation. Animate an object to fly in from the side of the page, 
spin, fade in, shrink and more. Choose when the animation takes place, at what speed and for how 
long. You can add animation to a text object or any object created with the Shapes tool or a pen tool.

To animate an object:

  1  Select the object you would like to animate
  2  Open the Properties tab
  3  Select the Object Animation tab 
  4  Using the drop-down lists provided, select the 

animation Type, Direction and Speed
  5  Select the animation timing from the Occurs 

drop-down list. You can set the animation to take 
place when you enter the page or when you click the 
object.

  6  Select the number of times the animation repeats 
from the drop-down list

Drop-down menus enable you to easily select 
and modify object animation properties.
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Using an Internet browser in your lesson
A lot of teachers like to use websites to illustrate concepts, add context to lesson activities, or 
provide additional information. In SMART Notebook software, you can insert an Internet browser 
onto your work area to display a web page.

To insert an Internet browser:

1  Open the Insert menu in SMART 
Notebook software

2  Select Internet Browser from the drop-
down menu. An Internet browser appears 
in the work area.

3  Double-click the address bar, type the 
address of the web page you want to 
browse to, and then click Go

4  Click the Pin Page button to pin the web 
page so that it appears in the Internet 
browser when you open the .notebook file

TIPS:

•  Select and drag text and images from a web page onto the SMART Notebook page. This 
is a great technique for teaching students how to collect and organize Internet research.

•  Use the Internet browser to stream online videos
•  Resize the Internet browser to maximize the viewable area of the page
•  Insert multiple Internet browsers onto a page to compare websites to each other
•  Draw, use SMART Notebook tools and use objects from the Gallery over any web content
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Using SMART Recorder
With SMART Recorder, you can make a video recording of your lesson, no matter which 
applications you are using on the interactive whiteboard. If you have a microphone attached, you 
can also record your voice. For example, this feature enables you to record sample math problems, 
incorporating the use of the on-screen calculator or spreadsheet, then replay the file as a review for 
your students or for those who missed the lesson. Recordings can be played using 
Windows® Media® Player (available free from windowsmedia.com/download). You can also use 
the SMART Recorder to record student work on the interactive whiteboard as a form of assessment.

SMART Recorder has a simple three-button interface 
that enables you to control the recording process. 

To record actions on the SMART Notebook page:

  1  Click the Record button. By default, 
SMART Recorder records the entire work area, 
although you can modify this setting.

  2  Complete the actions you would like to record
  3  Use the Pause and Record buttons throughout 

the recording as required
  4  Click the Stop button to end the recording
  5  You will be prompted to save the file. Select a location, name the file and click Save.
  6  The Recording Complete dialog box appears, providing details of the recording, including file 

size and recording time
  7  If you would like to immediately view your recording, check Play Recording. If you’re using a 

Mac computer, check Play Movie.
  8  Click OK

Record Pause Stop
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Setting the recording area
SMART Recorder has three options for the recorded 
region of the work area. Selecting a smaller recording 
area will reduce the file size and can eliminate 
distractions from the recording, such as the taskbar or 
any applications that are open but not necessary for the 
lesson.

To specify the portion of your desktop that you would like 
to record, click the arrow beside the Record button, and 
select from the following three options: 

•  Record Desktop (Default) – Record the entire desktop
•  Record Area – Select the area of the screen you would like to record
•  Record Window – Choose a window that you would like to record

Record Area has been selected. Therefore, only the area within the red border will be recorded. This will 
eliminate distractions such as the Calculator, Notepad and desktop icons.
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SMART Recorder menu
The SMART Recorder menu button provides access to several options and settings that you can 
modify to make SMART Recorder work best for you. To access these settings, select Options from 
the Recorder menu to launch the Options dialog box.

The Recording Quality 
tab enables you to adjust 
the quality levels of the 
sound and video recorded, 
which also has an impact 
on file size. For example, 
you can change the 
number of frames per 
second you record. Movies 
recorded at a low frame 
rate have a smaller file size 
than those with a higher 
frame rate, but the visual 
quality of the movie is 
reduced. 

The Video Format tab 
enables you to choose a 
file format to save your 
movie. The Windows 
Media Video Files option 
creates a file that can be 
viewed with Windows 
Media Player. The SMART 
Recorder Video option creates a more compressed file, resulting in a smaller file size. This file can 
be viewed only if SMART Board software is installed on the computer playing the video.

Select the Target Files tab to change where your Recorder files are saved on your computer. 

The Watermark tab enables you to add an image or text watermark to your recording, which would 
be visible anytime the file is played. You could use this feature to include course or unit titles, the 
date of the lesson or your school’s logo. You can adjust the placement of the watermark on the 
recording, and the font size, style and transparency of the watermark. You can also set a standard 
watermark to use each time you create a recording or select Turn off watermark when 
SMART Recorder closes to revert to using no watermark.
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Review: Integrating rich media into lesson activities
1  How do you attach a sound file to an object?

2  What settings can you change to reduce the file size of a SMART Recorder recording?

3  What are some creative ways to use the Internet Browser in your classroom?
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Review: Integrating rich media into lesson activities
1  How do you attach a sound file to an object?

Select the object you would like to attach a sound file to and select Sound from its 
drop-down menu. The Insert Sound dialog box appears. Click Browse to locate and 
select the sound file. Select whether you’d like to launch the sound by clicking a corner 
icon or the object, and click OK. 

If you’re using a Mac computer, select the object that you would like to attach a sound file 
to and select Sound from its drop-down menu. A dialog box appears. Click Choose 
File... to locate and select the sound file. Select whether you’d like to launch the sound by 
clicking a corner icon or the object, and click Attach Sound.

2  What settings can you change to reduce the file size of a SMART Recorder recording?

Changing the recording area, file type and recording quality will reduce the file size.

3  What are some creative ways to use an Internet browser in your classroom?

There are many creative ways to use an Internet browser. Some ideas include:

•  Displaying guiding questions and collecting information when modeling a research or 
inquiry project

•  Viewing an online video
•  Integrating the Internet browser into the lesson by adding content and using objects 

from the Gallery to interact with it
•  Embedding learning games, maps, simulations and other Internet-specific content into 

the context of the lesson
•  Using multiple Internet browsers to compare and contrast content
•  Using the integrated Internet browser to keep a routinely-used file dynamic and 

current. Display daily items like current events, weather, words-of-the-day or quotes.
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Lesson development 
in SMART Notebook 
software
How can SMART Notebook 
software help me to arrange my 
curr iculum into interest ing and 
ef fect ive lessons?

Integrate the tools and features covered in this workbook to complete the lesson or presentation file 
you’ve been working on throughout the day.
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Lesson development in SMART Notebook software
Complete the lesson activity or presentation file you’ve been creating. Ensure that your lesson or 
presentation file includes:

•  A title page
•  At least four pages
•  Only copyright-clear resources (such as those from the Gallery or the 

SMART Exchange website)
•  Answers for the lesson activity

When developing the lesson activity, try to include several of the skills you learned today:

Structuring and organizing lessons
•  Title pages
•  Page groups
•  Links
•  Attachments
•  My Content

Adding style to lesson activities
•  Themes
•  Custom pen styles
•  Tables

Building interactive lesson activities
•  Dual Page Display and Pin Page features
•  The Activity Builder add-on
•  Templates from the Lesson Activity Toolkit

Integrating rich media into lesson activities
•  Sound
•  Object animations
•  Internet browsers
•  SMART Recorder
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Concluding activity: 
Presenting lessons 
How can I  enhance my 
presentat ion of  lessons using 
SMART Notebook software?

This section aims to enhance your delivery of interactive whiteboard lessons through presentation 
tips and hands-on practice using interactive presentation tools.
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Concluding activity
In this course, you’ve learned how to make your lessons more effective by:

•  Applying lesson design best practices 
•  Structuring and organizing your lessons effectively
•  Adding style to increase the professionalism and clarity of lessons
•  Building lesson activities that are interactive and engaging
•  Integrating rich media into your lessons

To conclude this course, you’ll learn some tips for presenting lessons effectively on an interactive 
whiteboard, and have a chance to practice presenting.
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Presentation tips for interactive whiteboard users

Body positioning
Face your students as much as possible while manipulating the interactive whiteboard.

Keep your body position

When you need to reach something on the 
other side of the interactive whiteboard,

When writing on the interactive whiteboard,
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Concluding activity: Presenting lessons
Touch tips

TIP: Remember to orient your interactive whiteboard before every presentation to ensure an 
accurate reading of your touch.

The most effective hand position for moving 
or touching an object is

This is because
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Writing tips
Writing on an interactive whiteboard involves a slightly different technique than writing on a 
conventional whiteboard or chalkboard. Like any skill, it takes practice. Note some tips to improve 
your annotations.

Manipulate the interactive whiteboard from the screen
One of the advantages of an interactive whiteboard is that you can instruct from the front of the room 
– near the projected image – and navigate your digital lesson while facing your students. If you have 
access to a SMART Board 800 series interactive whiteboard you can even use gestures to navigate 
your digital lessons. If you navigate your interactive whiteboard from the back of the room so that 
you can use a mouse, you are not using the technology effectively.

Go ahead, mark up those documents
The interactive whiteboard is a great tool for highlighting and jotting notes on just about any type of 
application or document. So go ahead, use the tools as intended and mark up that electronic 
document. You can save your notes or delete them, it’s up to you.
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Concluding activity: Presenting lessons
Using interactive presentation tools
In SMART Notebook Training (Beginner and Intermediate), you were introduced to a number of 
tools that you can use when presenting lessons.

Concluding activity
Independently or with a colleague, review the lesson or presentation file you worked on throughout 
the day. Using the list below as a guide, explain how you might use each tool when presenting 
a lesson. 

Circle three interactive tools to use today if you’re called upon to share your lesson with the group.

Interactive tools Why/Where would I use this tool in my lesson delivery?

Circle to erase

Creative Pen

Dual Page Display

Export

Full Screen view

Transparent Background view

Handwriting recognition

Highlighter
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NOTE: A full list of gestures supported by SMART Board 800 series interactive whiteboards is 
included in the appendix of this learner workbook.

Insert Blank Page

Lesson Activity Toolkit tools

My Content

Page Recording

Recognize Shape

Internet browser

Gestures (SMART Board 800 
series interactive whiteboards)

Interactive tools Why/Where would I use this tool in my lesson delivery?
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Additional resources
What’s next?

Many resources are available to help you take the use of your SMART hardware and software to 
the next level, including free training materials and a special online community for educators.
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Additional resources
The SMART training and professional development 
web page
SMART’s training and professional development web page hosts additional training resources and 
support, including free learning resources, online training sessions and self-paced courses to help 
you effectively use any SMART product. 

Visit smarttech.com/training.

The SMART Learning Space
The SMART Learning Space (SLS) is a virtual learning environment loaded with highly innovative 
interactive learning experiences that will enhance your ability to teach, support learning and 
improve student outcomes.

 For more information, visit learningspace.smarttech.com and sign in or create a free account.

Teaching-centered learning
These high-impact lessons are designed by educators, for educators. You’ll learn how to use 
SMART’s interactive technology solutions to support your K–12 teaching strategies.

Certification
Demonstrate your expertise by attaining a SMART certification and join this exclusive group of 
highly competent SMART users.

On-site training
Whether you need product training, a program to develop your own trainers or comprehensive 
professional development planning, we’ll come to your location.

Training events
Our cost-effective, in-depth training sessions are held at scheduled times and locations across 
North America and around the world.

TIP: You can use the same e-mail address and password for both the SMART Exchange website 
and the SMART Learning Space. Signing in to one will keep you signed in to both.
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Technical training
Are you responsible for installing or supporting SMART products? Learn about our various technical 
training opportunities.

Distance learning
Don’t have the time or budget to attend a face-to-face training event? Join us online for a 
multi-session interactive learning experience. You can choose the topic and length of your course, 
all you need is a computer and a telephone.

Live online training
Get live online training in the form of free product overviews.

Self-paced e-learning
Our library of engaging self-paced courses are available for you to complete any time, any place 
and at your own pace.

The SMART support web page
SMART’s support web page offers a variety of product support options. Visit SMART support to 
download software, find installation and user's guides, how-to and troubleshooting articles, 
solutions for your SMART product and answers to your questions. You can also use SMART 
support to contact technical support and to register your SMART product.

Visit smarttech.com/support.
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Additional resources
The SMART Exchange website
Explore the SMART Exchange website at exchange.smarttech.com to find, preview and download 
over 50,000 classroom-ready resources that can be used with a variety of classroom 
technology products. 

By joining this online community, you can quickly access subject-specific, standards-correlated 
content that can be modified to suit the needs of any classroom. You’ll also be able to connect with 
colleagues locally or around the world to exchange lessons, ideas, insights and classroom success 
stories. Membership is free, so sign up today.
78

http://education.smarttech.com


SMART Notebook Training (Intermediate) Learner Workbook
Appendix
Features and functions of the 
SMART Board 800 series 
interactive whiteboard
Some SMART Notebook features are only available on the new SMART Board 800 series 
interactive whiteboards. This section references these features and functions so you can get started 
quickly with your SMART Board 800 series interactive whiteboard.
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Using DViT® technology
The SMART Board 800 series interactive whiteboard uses DViT (Digital Vision Touch) technology. 
DViT technology uses four digital cameras to track objects that touch the interactive surface.

With DViT technology, the interactive whiteboard preserves a high-resolution, shadow-free image 
quality, offering the best mix of accuracy, speed, image quality and ease of use.

Touch
The SMART Board 600 series interactive whiteboard, due to resistive technology, only recognizes 
touches with intent. The SMART Board 800 series interactive whiteboard, however, tracks visual 
rather than tactile input, which means that it recognizes even a light touch on the interactive surface 
as a touch with intent.

Gesture capabilities also set the 800 series apart. Gestures are touch-specific movements 
performed on the interactive surface to produce a specific effect such as rotating interactive content, 
zooming or panning. Due to the sensitivity of the digital cameras, the interactive whiteboard may 
recognize unintentional movements as gestures. 

To achieve the best results when you use your SMART Board 800 series interactive whiteboard, 
ensure that you:

•  Hold your fingers perpendicular to the interactive surface at the contact point
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•  Keep your other hand, elbows and loose clothing away from the interactive surface 
because they can generate unintentional commands

•  Keep your thumb and other fingers away from the interactive surface because they can 
generate unintentional commands

•  Quickly tap your finger on the interactive surface for click commands. Between presses, 
lift your finger away from the interactive surface so that your finger is out of the interactive 
whiteboard cameras’ views.
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•  Use your flattened hand, your palm or the bottom of your fist for erase commands 

•  Use the wide surface of the pen tray’s eraser for large areas, and use the smaller, angled 
surface for smaller areas. Don’t use the edge of the eraser because this could be 
interpreted incorrectly.

Writing and drawing
To write or draw on a SMART Board 800 series interactive whiteboard, you can use either your 
finger or the pen. Press a pen tray button to select a digital ink color before you begin writing. Once 
you’ve selected your color, press your finger or pen to the interactive surface to write or draw.

The on-screen keyboard
Press the Keyboard button to open the on-screen keyboard.

Right click
To make your next touch a right-click (Control-click), just press the Right-click button on the 
pen tray.
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Calligraphic Ink
Calligraphic Ink automatically smoothes the appearance of your writing and drawing.

NOTE: You only see the Calligraphic Ink button when you are connected to a SMART Board 
interactive whiteboard. 

Using touch recognition
A SMART Board 800 series interactive whiteboard recognizes three distinct touches. It 
differentiates between your finger and the pen to write and select, and your palm to erase. This 
means that you can pick up a pen and then write, select or erase without replacing the pen.

Using object awareness
A SMART Board 800 series interactive whiteboard uses object awareness to recognize whether 
you’re using your finger or the pen to write. To use object awareness, press a toolbar icon with your 
finger to write with your finger, or press a toolbar icon with the pen to write with the pen.

Using the lockable pen option
If you want to interact with the interactive whiteboard using an object that isn’t a pen or a finger, 
such as a tennis ball, pointer, or Koosh ball, you’ll need to turn on the lockable pen option.

To turn on the lockable pen option, press and hold any pen color button until it flashes. This locks 
the interactive whiteboard into pen mode so you can use any tool as a pen, not just your finger or 
the pen tool. To turn off the lockable pen option, press another pen color button. The pen color 
button will stop flashing, and you can go back to using your pen, finger and palm.
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Dual users
The SMART Board 800 series interactive whiteboard has dual-user capabilities, meaning that two 
people can write, draw and interact with the interactive whiteboard at the same time.

Using gestures
Using gestures instead of menu commands makes your use of the SMART Board interactive 
whiteboard even more intuitive.

Zoom
Zoom is a gesture that magnifies on-screen content. To zoom on an interactive whiteboard, place 
two fingers on the interactive surface and drag them in opposite directions.

Pan
Pan is a gesture that allows you to move the content in different directions on the screen. To pan 
on an interactive whiteboard, place two fingers on the interactive surface and move them in any 
direction at the same time.
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Swipe
Swipe is a gesture that allows you to move from one SMART Notebook page to another. To swipe 
on an interactive whiteboard, drag four fingers quickly across the interactive surface.

Rotate
Rotate is a gesture that allows you to turn an object. To rotate an object on an interactive 
whiteboard, press the object with two fingers and drag both fingers in the direction you want to turn 
the object. You can also rotate an object around its center.

Resize
Resize is a gesture that allows you to increase or decrease the size of an object. To resize an object 
in SMART Notebook software, press the object with two fingers and drag the fingers apart to 
enlarge. If you want to decrease the size of an object, press the object with two fingers and bring 
them closer together.
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Flick
Flick is a gesture that allows you to move an object in SMART Notebook software without having 
your finger on it – like a toss. To flick an object on an interactive whiteboard, press your finger on 
the object and move your finger swiftly in the direction you want to move the object. Remove your 
finger from the interactive surface as you complete the motion.
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Delivery formats
SMART’s training options are designed to work for you. We offer a variety of 

formats that cater to different budgets, schedules and learning styles. Browse the 

information below to discover the training format that best serves your needs.

Face to face
Whether you need product training or preparation for training others on  

SMART products, a SMART training specialist can help. We can come to you, or 

you can join us at one of our training events around the world.

Distance education
Don’t have the time or budget to attend a face-to-face training event? Join us  

online for a multi-session interactive learning experience. You can choose the 

topic and length of your course, all you need is a computer and a telephone.

Self-paced e-learning
The SMART Learning Space is an online learning environment packed with  

innovative, interactive eLearning courses that you can complete at your own pace.

Contact  
SMART Technologies
Toll Free 1.888.42.SMART  
(U.S./Canada)
or +1.403.245.0333

Facebook
facebook.com/SMARTClassrooms

Twitter
twitter.com/SMART_Tech
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